APPLICATION NOTE

AC500 HOW TO USE OPC SERVER WITH V2 AND V3 CPU'S
Contents

1 Introduction .................................................................................................................4
  1.1 Scope of the document .........................................................................................4
  1.2 Compatibility .........................................................................................................4
  1.3 Overview ...............................................................................................................4

2 Hints ..............................................................................................................................5
  2.1 Documents reference ............................................................................................5
  2.2 Work flow ..............................................................................................................6
    2.2.1 Consideration and Preparation .......................................................................6
    2.2.2 Commissioning OPC-Server ..........................................................................7
    2.2.3 Adjustment to the OPC client .........................................................................7
  2.3 When using OPC server V2 or V3 .........................................................................8
  2.4 Default folder and contents ...................................................................................8
    2.4.1 Win7 ... Win10, Windows Server 2008 64Bit ... 2016 64Bit .........................8
    2.4.2 Win7 32Bit, Windows Server 2008 32Bit ......................................................9
    2.4.3 WinXP 32Bit, Windows Server 2003 32Bit ...................................................10
  2.5 Installation OPC Server .........................................................................................11
    2.5.1 Installing with Automation Builder Installer ................................................11
    2.5.2 Manual Registration and Unregistration ......................................................13
    2.5.3 Example Register OPC server V3 as system service .....................................13
    2.5.4 OPC clients for tests .....................................................................................15
  2.6 CoDeSys Settings ..................................................................................................15
    2.6.1 Configure Symbol File (AC500 V1 and V2) ..................................................15
    2.6.2 Create and download symbol file (AC500 V1 and V2) .................................18
    2.6.3 Create Symbol File (AC500 V3) ..................................................................19
  2.7 Configure OPC Server ..........................................................................................20
    2.7.1 Configure OPC Server V2 (Only for AC500 V1 and 2) ..................................20
    2.7.2 Configure OPC Server V3 for AC500 V2 ....................................................23
    2.7.3 Configure OPC Server V3 for AC500 V3 ....................................................26
    2.7.4 Check OPC function with AC500 .................................................................30
    2.7.5 Check OPC Server V2 ..................................................................................30
    2.7.6 Check OPC Server V3 ..................................................................................31
    2.7.7 Check Processes with Windows Task Manager .............................................31
  2.8 Configure AlarmEvents .........................................................................................32
    2.8.1 Check AlarmEvents ....................................................................................32
  2.9 Configure User account for OPC server ..............................................................32
    2.9.1 OPC Server V3 on Windows Server 2003, ... 2016 ....................................32
  2.10 Session isolation: How to deal with OPC Server and Automation Builder in different sessions? ..................................................................................................................35
    2.10.1 Situation ......................................................................................................35
    2.10.2 Difficulty .....................................................................................................36
    2.10.3 Different solutions: .....................................................................................36
  2.11 Gateway communication not possible if gateway port is used by other application .................................................................37
    2.11.1 Windows Server 2012 ...............................................................................38
  2.12 OPC server does not load the symbol file from AC500 .........................................39

3 Examples ......................................................................................................................40
  3.1 OPC Client as a Windows service with AB on the same PC ...................................40
    3.1.1 Host system .................................................................................................40
    3.1.2 PC configuration .........................................................................................40
    3.1.3 DigiVis500 configuration ............................................................................41
    3.1.4 Guest system ............................................................................................43
3.2 OPC Server as service and Automation Builder access to AC500 V2 ............................................ 45
  3.2.1 Communication settings for OPC Server with OPCConfig.exe .............................................. 45
  3.2.2 Communication settings for PLC AC500v2 in Automation Builder ........................................ 46
3.3 Windows Server 2016 with OPC Server and CoDeSys Gateway as service and Automation Builder access to AC500 V2 and AC500 V3 ................................................................. 47
  3.3.1 AutomationBuilder project with PLC_AC500_V2 (PM556-ETH) and PLC_AC500_V3 (PM5650-2ETH) ............................................................................................................. 47
  3.3.2 Communication settings for OPC Server with OPCConfig.exe ................................................. 49
3.4 How can the OPC Server V3 communicate with duplicated Automation Builder AC500 V2 projects? ......................................................................................................................... 50
  3.4.1 Communication settings for OPC Server with OPCConfig.exe ................................................. 51
  3.4.2 Test of the OPC communication with MatrikonOPCExplorer .................................................. 53
4 Appendix ........................................................................................................................................ 54
  4.1 Test OPC Function without AC500 ............................................................................................. 54
    4.1.1 AC500 project .................................................................................................................... 54
    4.1.2 Configure OPC Server V3 ................................................................................................. 57
    4.1.3 Configure OPC Server V2 ................................................................................................. 58
    4.1.4 Check OPC Server with MatrikonOPCExplorer ................................................................. 59
    4.1.5 Check Processes with Windows Task Manager ................................................................. 60
    4.1.6 Summary ......................................................................................................................... 61
  4.2 Windows 7, 64Bit with OPC Server V3 access to the local Symbol file. ........................................ 61
  4.3 Behavior OPC Server V3 via Interface IOPCAsyncIO ................................................................. 64
  4.4 Comparison with OPC Server V2 to V3: Transmission rate ..................................................... 65
  4.5 Performance Comparison with OPC Server V3 and different TCP/IP drivers: ......................... 65
  4.6 OPC Server V3 with S+ ............................................................................................................. 66
  4.7 Behaviour of the OPC Server V3 with DigiVis500 ..................................................................... 67
  4.8 How can one demonstrate DigiVis500 without AC500? .......................................................... 68
    4.8.1 PC configuration .............................................................................................................. 68
    4.8.2 DigiVis500 configuration ............................................................................................... 69
    4.8.3 Changing the OPCConfig to Simulation mode ............................................................... 70
    4.8.4 Checking with MatrikonOPCExplorer and DigiVis500 ................................................... 70
  4.9 How do you create an OPC client with Microsoft Excel? ......................................................... 71
1 Introduction

1.1 Scope of the document

This note describes the use of server OPC V2 and V3 in the practice.

1.2 Compatibility

The application example explained in this document have been used with the below engineering system versions. They should also work with other versions, nevertheless some small adaptations may be necessary, for future versions.

- AC500 V2 and AC500 V3 PLCs
- AutomationBuilder V1.0.4 (CBP V2.3.0) to AutomationBuilder V2.2.1 or newer (noted below as AB)

1.3 Overview
## 2 Hints

### 2.1 Documents reference

The following documents include useful information and instruction of OPC:

<table>
<thead>
<tr>
<th>Reference</th>
<th>File name</th>
<th>Comment</th>
<th>Where to find</th>
</tr>
</thead>
<tbody>
<tr>
<td>REF 1</td>
<td>AeConfigurator_UserGuide.pdf CoDeSys.OPC_Server.V3_User_Guide.pdf CoDeSys.OPC_Server.V3_Benutzerhandbuch.pdf</td>
<td>OPC V3</td>
<td>c:\Program Files (x86)\3S CODESYS\CODESYS OPC Server 3\</td>
</tr>
<tr>
<td>REF 2</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>REF 4</td>
<td>Setting gateway server</td>
<td>general</td>
<td>AutomationBuilder Help, CODESYS Development System, Principle of a gateway system.</td>
</tr>
<tr>
<td>REF 5</td>
<td>Configure a Symbol File</td>
<td>general</td>
<td>AutomationBuilder Help: Configuration in Automation Builder for AC500 V2 Products &gt; Server Installation &gt; OPC Server for AC500 V2 Products &gt; Hints &gt; Symbol File &gt; AC500 (V1 and V2) &gt; Configure a Symbol File</td>
</tr>
<tr>
<td>REF 6</td>
<td>OPC_20_how_to_use_E.pdf OPC_20_how_to_use_D.pdf OPC_20_how_to_use_ru.pdf</td>
<td>OPC V2</td>
<td>C:\Program Files\3S Software-CoDeSysOPC C:\Program Files (x86)\3S Software\CoDeSysOPC</td>
</tr>
<tr>
<td>REF 7</td>
<td>Example_AC500_HA_CS31_V244_3ADR023070M0201.pdf</td>
<td>OPC V3, HA</td>
<td>c:\Users\Public\Documents\AutomationBuilder\Examples\HA-CS31\</td>
</tr>
</tbody>
</table>
2.2 Work flow

2.2.1 Consideration and Preparation

Choose the suitable OPC Server for the target OPC client

Are current OPC versions installed?

Yes

Install it from the current Automation Builder Installer

No

See Hints, When using OPC server V2 or V3

See Hints, OPC Server versions and OPC tools

See Hints, Installation OPC Server

CoDeSys Settings
2.2.2 Commissioning OPC-Server

- Define OPC items separately in Global Variables
- Configure Symbol file
- CPU FW V2 and download file to PLC?
  - Yes
    - Active „Download symbol file“
    - Build, download and flash program
  - No
- OPC Configuration

In REF7 and REF8 there are examples about how to commission OPC communication step by step.

- See Hints, Configure symbol file
- See Hints, Create and Download symbol file
- Check *sym file in project folder. Check the date of *sdb in /Gateway

2.2.3 Adjustment to the OPC client

- Assign OPC server program to user
- Register OPC server as system service for user
- Test with target OPC client

- See REF 4
- See Hints, Configure User account for OPC server

Adjustment to target OPC client
2.3 When using OPC server V2 or V3

<table>
<thead>
<tr>
<th>Required functions of the OPC Client</th>
<th>OPC Server V2</th>
<th>OPC Server V3</th>
<th>Hints</th>
</tr>
</thead>
<tbody>
<tr>
<td>Support Win XP, Win 7 32Bit, Win 7 64Bit, Windows Server 2003, Windows Server 2008</td>
<td>X</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>OPC client runs as service</td>
<td>-</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>Support Alarm/Event</td>
<td>-</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>Support AC500 HA</td>
<td>-</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>OPC-Performance</td>
<td>-</td>
<td>faster</td>
<td></td>
</tr>
<tr>
<td>Support VB, VBA OPC clients (Auto-</td>
<td>X</td>
<td>X</td>
<td>OPC Server V3 supports also VBA OPC Clients, but OPC Server V2 must be installed also because of an otherwise missing DLL.</td>
</tr>
<tr>
<td>mation Interface, Automation Wrapper)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Resources friendly to old OPC clients, which support only the old OPC DA 1.0a (Async I/O 1.0a) groups.</td>
<td>X</td>
<td>X</td>
<td>See Hints, Behaviour OPC Server V3 via Interface IOPCAsyncIO</td>
</tr>
<tr>
<td>Simulation without AC500</td>
<td>-</td>
<td>X</td>
<td></td>
</tr>
</tbody>
</table>

NOTICE
If several OPC clients are used at the same time, they must run in the same session.
See Hints, Session isolation

2.4 Default folder and contents
Sight with Folder Options “Show hidden files, folders.....” and “extensions for known file types”.

2.4.1 Win7 ... Win10, Windows Server 2008 64Bit ... 2016 64Bit

<table>
<thead>
<tr>
<th>OPC Server V2</th>
<th>Win7 ... Win10, Windows Server 2008 64Bit ... 2016 64Bit</th>
</tr>
</thead>
<tbody>
<tr>
<td>CODESYSOPC.EXE</td>
<td>c:\Program Files (x86)\3S Software\CoDeSysOPC\</td>
</tr>
<tr>
<td>OPCCONFIG.EXE</td>
<td></td>
</tr>
<tr>
<td>OPCCOMMONSETUP.EXE</td>
<td></td>
</tr>
<tr>
<td>OPC_CONFIG.E.EXE</td>
<td></td>
</tr>
<tr>
<td>OPC_20_HOW_TO_USE_D.PDF</td>
<td></td>
</tr>
<tr>
<td>OPC_20_HOW_TO_USE_E.PDF</td>
<td></td>
</tr>
<tr>
<td>OPC_20_HOW_TO_USE_RU.PDF</td>
<td></td>
</tr>
<tr>
<td>CODESYSOPC.INI</td>
<td>c:\PROGRAMDATA\CODESYSOPCv2.3</td>
</tr>
<tr>
<td>OPCSERVER.LOG</td>
<td>c:\PROGRAMDATA\CODESYSOPC</td>
</tr>
<tr>
<td>SYMBOL FILE *.SDB, *.SYM</td>
<td>AB OPEN, AFTER PROJECT BUILD OR REBUILD ALL: IN THE PROJECT FOLDER</td>
</tr>
<tr>
<td>SYMBOL FILE *.SDB</td>
<td>AFTER LOGIN IN AC500: C:\PROGRAMDATA\GATEWAY FILES\</td>
</tr>
<tr>
<td></td>
<td>AFTER START CODESYS OPC SERVER</td>
</tr>
<tr>
<td></td>
<td>C:\PROGRAMDATA\GATEWAY FILES\UPLOAD\</td>
</tr>
<tr>
<td>GATEWAY.EXE</td>
<td>C:\WINDOWS\SYSWOW64\GATEWAY.EXE</td>
</tr>
<tr>
<td>GATEWAY_MANUAL.PDF</td>
<td></td>
</tr>
</tbody>
</table>
### OPC Server V3

<table>
<thead>
<tr>
<th>File</th>
<th>Path</th>
</tr>
</thead>
<tbody>
<tr>
<td>WINCODESYSOPC.EXE</td>
<td>C:\Program Files (X86)\3S CODESYS\CODESYS OPC SERVER 3\</td>
</tr>
<tr>
<td>OPCCONFIG.EXE</td>
<td></td>
</tr>
<tr>
<td>AECONFIGURATION.EXE</td>
<td></td>
</tr>
<tr>
<td>CODESYS_OPC_SERVER_V3_USER_GUIDE.PDF</td>
<td></td>
</tr>
<tr>
<td>CODESYS_OPC_SERVER_V3_BENUTZERHANDBUCH.PDF</td>
<td></td>
</tr>
<tr>
<td>AECONFIGURATOR_USERGUIDE.PDF</td>
<td></td>
</tr>
<tr>
<td>OPCSERVER.LOG</td>
<td>C:\PROGRAMDATA\CODESYSOPC\</td>
</tr>
<tr>
<td>OPCSERVER.INI</td>
<td></td>
</tr>
<tr>
<td>OPCSERVERA.INI (OPTIONAL BY ALARM AND EVENTS CONFIGURATION)</td>
<td></td>
</tr>
<tr>
<td>SYMBOL FILE *.SDB, *.SYM</td>
<td>AB OPEN, AFTER PROJECT BUILD OR REBUILD ALL: IN THE PROJECT FOLDER</td>
</tr>
<tr>
<td>SYMBOL FILE *.SDB</td>
<td>AFTER LOGIN IN AC500: C:\PROGRAMDATA\GATEWAY FILES\</td>
</tr>
<tr>
<td></td>
<td>AFTER START CODESYS OPC SERVER C:\PROGRAMDATA\GATEWAY FILES\UPLOAD\</td>
</tr>
<tr>
<td>GATEWAY.EXE</td>
<td>C:\WINDOWS\SYSSWOW64\GATEWAY.EXE</td>
</tr>
<tr>
<td>GATEWAY MANUAL.PDF</td>
<td></td>
</tr>
</tbody>
</table>

#### 2.4.2 Win7 32Bit, Windows Server 2008 32Bit

<table>
<thead>
<tr>
<th>OPC Server V2</th>
<th>Win7 32Bit, Windows Server 2008 32Bit</th>
</tr>
</thead>
<tbody>
<tr>
<td>CODESYSOPC.EXE</td>
<td>C:\Program Files\3S Software\CoDeSysOPC\</td>
</tr>
<tr>
<td>OPCCONFIG.EXE</td>
<td></td>
</tr>
<tr>
<td>OPCCONFIG.EXE</td>
<td></td>
</tr>
<tr>
<td>OPC_20_HOW_TO_USE_D.PDF</td>
<td></td>
</tr>
<tr>
<td>OPC_20_HOW_TO_USE_E.PDF</td>
<td></td>
</tr>
<tr>
<td>CODESYSOPC.INI</td>
<td>C:\ProgramData\CoDeSysOPCV2.3</td>
</tr>
<tr>
<td>OPCSERVERA.INI</td>
<td></td>
</tr>
<tr>
<td>OPCSERVERA.INI (OPTIONAL BY ALARM AND EVENTS CONFIGURATION)</td>
<td></td>
</tr>
<tr>
<td>SYMBOL FILE *.SDB, *.SYM</td>
<td>AB OPEN, AFTER PROJECT BUILD OR REBUILD ALL: IN THE PROJECT FOLDER</td>
</tr>
<tr>
<td>SYMBOL FILE *.SDB</td>
<td>AFTER LOGIN IN AC500: C:\PROGRAMDATA\GATEWAY FILES\</td>
</tr>
<tr>
<td></td>
<td>AFTER START CODESYS OPC SERVER C:\PROGRAMDATA\GATEWAY FILES\UPLOAD\</td>
</tr>
<tr>
<td>GATEWAY.EXE</td>
<td>C:\WINDOWS\SYSTEM32\GATEWAY.EXE</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>OPC Server V3</th>
<th>Win7 32Bit, Windows Server 2008 32Bit</th>
</tr>
</thead>
<tbody>
<tr>
<td>WINCODESYSOPC.EXE</td>
<td>C:\PROGRAM FILES\3S CODESYS\CODESYS OPC SERVER 3\</td>
</tr>
<tr>
<td>OPCCONFIG.EXE</td>
<td></td>
</tr>
<tr>
<td>AECONFIGURATION.EXE</td>
<td></td>
</tr>
<tr>
<td>CODESYS_OPC_SERVER_V3_USER_GUIDE.PDF</td>
<td></td>
</tr>
<tr>
<td>CODESYS_OPC_SERVER_V3_BENUTZERHANDBUCH.PDF</td>
<td></td>
</tr>
<tr>
<td>AECONFIGURATOR_USERGUIDE.PDF</td>
<td></td>
</tr>
<tr>
<td>OPCSERVER.INI</td>
<td>C:\PROGRAMDATA\CODESYSOPC\</td>
</tr>
<tr>
<td>OPCSERVERA.INI</td>
<td></td>
</tr>
<tr>
<td>OPCSERVERA.INI (OPTIONAL BY ALARM AND EVENTS CONFIGURATION)</td>
<td></td>
</tr>
<tr>
<td>SYMBOL FILE *.SDB, *.SYM</td>
<td>AB OPEN, AFTER PROJECT BUILD OR REBUILD ALL: IN THE PROJECT FOLDER</td>
</tr>
<tr>
<td>SYMBOL FILE *.SDB</td>
<td>AFTER LOGIN IN AC500: C:\PROGRAMDATA\GATEWAY FILES\</td>
</tr>
<tr>
<td></td>
<td>AFTER START CODESYS OPC SERVER C:\PROGRAMDATA\GATEWAY FILES\UPLOAD\</td>
</tr>
<tr>
<td>GATEWAY.EXE</td>
<td>C:\WINDOWS\SYSTEM32\GATEWAY.EXE</td>
</tr>
</tbody>
</table>
### 2.4.3 WinXP 32Bit, Windows Server 2003 32Bit

<table>
<thead>
<tr>
<th>OPC Server V2</th>
<th>Win7 32Bit, Windows Server 2003 32Bit</th>
</tr>
</thead>
<tbody>
<tr>
<td>CODESYSOPC.EXE</td>
<td>c:\Program Files\3S Software\CoDeSysOPC\</td>
</tr>
<tr>
<td>OPCCONFIG.EXE</td>
<td></td>
</tr>
<tr>
<td>OPCCONFIG_E.EXE</td>
<td></td>
</tr>
<tr>
<td>OPC_20_HOW_TO_USE_D.PDF</td>
<td></td>
</tr>
<tr>
<td>OPC_20_HOW_TO_USE_E.PDF</td>
<td></td>
</tr>
<tr>
<td>CODESYSOPC.INI</td>
<td></td>
</tr>
<tr>
<td>OPCSERVER.LOG</td>
<td></td>
</tr>
<tr>
<td>SYMBOL FILE *.SDB, *.SYM</td>
<td>AB OPEN, AFTER PROJECT BUILD OR REBUILD ALL: IN THE PROJECT FOLDER</td>
</tr>
<tr>
<td>SYMBOL FILE *.SDB</td>
<td>AFTER LOGIN IN AC500: C:\WINDOWS\GATEWAY FILES\ AFTER START CODESYS OPC SERVER C:\WINDOWS\GATEWAY FILES\UPLOAD\</td>
</tr>
<tr>
<td>GATEWAY.EXE</td>
<td>C:\WINDOWS\SYSTEM32\GATEWAY.EXE</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>OPC Server V3</th>
<th>Win7 32Bit, Windows Server 2008 32Bit</th>
</tr>
</thead>
<tbody>
<tr>
<td>WINCODESYSOPC.EXE</td>
<td>C:\PROGRAM FILES\3S CODESYS\CODESYS OPC SERVER 3\</td>
</tr>
<tr>
<td>OPCCONFIG.EXE</td>
<td></td>
</tr>
<tr>
<td>AECONFIGURATION.EXE</td>
<td></td>
</tr>
<tr>
<td>CODESYS_OPC_SERVER_V3_USERGUIDE.PDF</td>
<td></td>
</tr>
<tr>
<td>CODESYS_OPC_SERVER_V3_BENUTZERHANDBUCH.PDF</td>
<td></td>
</tr>
<tr>
<td>AECONFIGURATOR_USERGUIDE.PDF</td>
<td></td>
</tr>
<tr>
<td>OPCSERVER.INI</td>
<td></td>
</tr>
<tr>
<td>OPCSERVERA.INI</td>
<td></td>
</tr>
<tr>
<td>OPCSERVER.LOG</td>
<td></td>
</tr>
<tr>
<td>SYMBOL FILE *.SDB, *.SYM</td>
<td>AB OPEN, AFTER PROJECT BUILD OR REBUILD ALL: IN THE PROJECT FOLDER</td>
</tr>
<tr>
<td>SYMBOL FILE *.SDB</td>
<td>AFTER LOGIN IN AC500: C:\WINDOWS\GATEWAY FILES\ AFTER START CODESYS OPC SERVER C:\WINDOWS\GATEWAY FILES\UPLOAD\</td>
</tr>
<tr>
<td>GATEWAY.EXE</td>
<td>C:\WINDOWS\SYSTEM32\GATEWAY.EXE</td>
</tr>
</tbody>
</table>
2.5 Installation OPC Server

Here is described how the server OPC V2 and V3 (without AB) are installed.

Before you can do this, you must close all OPC clients, the ABB OPC Tunnel and the gateway (CoDeSys gateway server) on your PC. Check this with the Windows Task-Manager.

The processes of
- Gateway.exe
- CoDeSysOPC.exe
- WinCoDeSysOPC.exe
- OCTsvc.exe
must disappear.

If not:
- End the processes with the Windows Task-Manager.
- Stop the ABB OPC Tunnel Windows Component Service, Services (local).

2.5.1 Installing with Automation Builder Installer

Install the OPC server V2 with installer for Automation Builder from Homepage.

http://new.abb.com/plc/automationbuilder/platform/software

Push Download Button and run Installer
Push "Installer Options and Additional Tools"

Choose "Install Additional Tools"
Agree License Terms
Choose Version 2 or 3 and install

2.5.2 Manual Registration and Unregistration

During the installation all needed files are installed for OPC and the OPC Server is registered automatically as user application.

Further on there is the possibility to register resp. to uninstall the OPC Server manually either as COM Server (user application) or as service.

### TIP

Register the OPC server in the registry as interactive software with command:
- For OPC 3: WinCoDeSysOPC/RegServer
- For OPC 2: CoDeSysOPC/RegServer

Register the OPC server as system service with command:
- For OPC 3: WinCoDeSysOPC/Service
- For OPC 2: CoDeSysOPC/Service

Unregister the OPC server from registry and from service entry with command:
- For OPC 3: WinCoDeSysOPC/UnRegServer
- For OPC 2: CoDeSysOPC/UnRegServer

Please see REF1 chapter 3 (OPC 3) and REF6 chapter 2.2 (OPC 2) for details.

2.5.3 Example Register OPC server V3 as system service

Situation: The OPC server V3 is registered as COM Server (user application) and should now registered as a system service.

### CAUTION!

Close all programs, processes and services which access the OPC server before do the following work.
Before registering the OPC server as system service, it must be unregistered first.
1. Start the Command Prompt with command `cmd: “Run as administrator”`

2. Change to the CODESYS OPC Server 3 installation folder.

3. Unregister the OPC server with `WinCoDeSysOPC /UnRegServer`.

4. Register the OPC server as system service with `WinCoDeSysOPC /Service`.

5. Restart the Windows OS.

6. If Windows is started, the CoDeSysOPCDAService is added in Control Panel\All Control Panel Items\Administrative Tools\Services with the properties: Startup Type “Manual”. Via the properties is it possible to change the startup behavior.

7. With Task Manager can be checked, if the OPCServer V3 is successfully registered as Service and running: WinCoDeSysOPC.exe and the Gateway.exe is running in session 0.
2.5.4 **OPC clients for tests**

Free of Charge Test Clients can be found in the Web

MatrikonOPC Explorer:  

Free OPC Software:  
https://www.opcconnect.com/freestuf.php

2.6 **CoDeSys Settings**

Refer to REF5 Online help chapter OPC for details.

**NOTICE**

2.6.1 **Configure Symbol File (AC500 V1 and V2)**

Symbol includes the items (variables) which exchanges with PLC, this is needed for OPC communication. After build the project, two symbol files will be generated under the project (.pro) folder. One is .sdb, another is .sym.

File .sdb is a binary file and is needed by OPC server indeed. File .sym has the same content but in text, which can be understood by human. It can be used to check if it is generated correctly.

Please refer to REF5 Online help for how to configure CoDeSys for symbol file.

**NOTICE**
Start of the Symbol configuration with Project, Options, checkbox "Dump symbol entries" must be enabled, Configure symbol file ...
Sometimes the symbol file looks different than really configured, e.g. more symbols than expected. In such case please follow the steps to create a clean symbol file:

1. Go to Project → Options → Symbol configuration → Configure symbol file...
2. Uncheck all the options in Symbol file configuration and confirm with OK and OK again (2 times OK).

3. Go to Project → Options → Symbol configuration → Configure symbol file... again, first choose the variables which should be communicated as symbol:

4. Then check the following options:
2.6.2 Create and download symbol file (AC500 V1 and V2)

For CPU with FW V1:
If PLC hardware is available, please use “login / download program” to copy the .sdb file automatically into Gateway folder, e.g. “C:\WINNT\Gateway Files”.
If there is no PLC, the .sdb file should be copied into Gateway folder by hand.
When OPC server is started, the .sdb file will be copied to e.g. “C:\WINNT\Gateway Files\Upload” for Gateway communication.

For CPU with FW V2:
Following option can be chosen to download the .sdb file also to PLC.
When OPC server is started, the .sdb file will be copied from PLC (if available) or from Gateway folder to “C:\WINNT\Gateway Files\Upload” for Gateway communication.

**NOTICE**

Do not configure the program as a cyclic program, please use a task configuration. Call the PLC Browser and have a look to the task time (command “tsk in the command line). For example, the program has a cycle time of 40ms, use a task time of 50 or 60ms. So, the CPU has time to answer the OPC request from the OPC Server between the tasks.

### 2.6.3 Create Symbol File (AC500 V3)

In CODESYS V3 Project Select Application

```
Right Mouse Click/Add Object
```

Select Symbol Configuration
Choose Defaults and push “Add”
Select your Programs and or single Symbols and push Build
With Double Click to Symbol Configuration you can change the Symbol Configuration
Symbol File will be automatically download to PLC with Project Download.
Please choose only Symbols you need in order to don’t increase traffic and Load.

2.7 Configure OPC Server

2.7.1 Configure OPC Server V2 (Only for AC500 V1 and 2)
Start 3S Software/Communication/CoDeSysOPC Configurator

**NOTICE**
Update Rate may not be 0 (ms)! The default value of 200 ms is suitable value of many applications. The adjustment for the Update Rate depends on the number of symbols (variables). For a big number of symbols, it can be better to increase the update rate.
If *.sdb in the Gateway Files on PC, the project name must be identical with project name in CoDeSys. The extension is not necessary.
If*.sdb on AC500 V2.x, the project name is not required (can be empty).

The checkboxes “Active”, “Motorola Byteorder” and “No Login-Service” must be checked.

The checkbox “Enable logging” allows a later diagnosis.

Setup Connection: Click on Connection, Click on Edit, choose a channel of the Channel list (normally the channel which is used for programming) or click new

Define Name and click to TCP/IP OK
Double click to value field after Address (192.168.0.10). Fill in Address and end with Return OK

Previous settings of gateway channels are only visible, after the first time the connection has been built up.
See Ref 5: CoDeSys, Help, Contents, System Technology, OPC, Use of the CoDeSys OPC server, Configuration of the OPC server with OPCconfig.exe

If more than one PLC, then repeat for the other PLCs
Save the configuration in Menu „File“ and then “Exit”.
2.7.2 Configure OPC Server V3 for AC500 V2

Start 3S CoDeSys/CoDeSysOPC Server V3/OPC Configurator. The current configuration of the OPCServer.ini is shown.

If the configuration is needed furthermore, store it under a new name.

NOTICE Update Rate may not be 0 (ms)! The default value of 200 ms is suitable value of many applications. The adjustment for the Update Rate depends on the number of symbols (variables). For a big number of symbols, it would be better to increase the update rate.
If the *.sdb files should be loaded from the “Gateway Files” directory on PC, the project name must be identical with project name in CoDeSys. The extension is not necessary.

If the symbol information should be loaded from AC500 V2.x, the project name is not required (can be empty).

The checkboxes “Active”, “Motorola Byteorder” and “No Login-Service” must be checked.

The checkbox “Enable logging” allows a later diagnosis.

Setup Connection: Click on Connection, Click on Edit, choose a channel of the Channel list (normally the channel which is used for programming) or click new

If more than one PLC, then repeat for the other PLCs (Gateway depends on Version of AC500)
Previous settings of gateway channels are only visible, after the first time the connection has been built up.
See Ref5: CoDeSys, Help, Contents, System Technology, OPC, Use of the CoDeSys OPC server, Configuration of the OPC server with OPCconfig.exe

Setting up the desired gateway server

Connection: TCP/IP
TCP/IP must always be used, whether the gateway server is running on your local or a different computer.

See REF4: For further information see: AutomationBuilder Help, CODESYS Development System, principle of a gateway system.

Save as
2.7.3 Configure OPC Server V3 for AC500 V3

Start 3S CoDeSys/ CoDeSysOPC Server V3/OPC Configurator. The current configuration of the OPCServer.ini is shown.

If the configuration is needed furthermore, store it under a new name.
NOTICE

Update Rate may not be 0 (ms)! The default value of 200 ms is suitable value of many applications. The adjustment for the Update Rate depends on the number of symbols (variables). For a big number of symbols, it would be better to increase the update rate.

For AC500 V3 please choose “Gateway 3”
Push Edit

Fill in TCP/IP Address of Target PLC and mark the checkbox „Use Tcp/Ip block driver”.

Fill in TCP/IP Address a second Time
Push OK

Save OPCserver.ini and close OPCConfig
2.7.4 Check OPC function with AC500

For check OPC function without AC500, see Examples “Test OPC Function without AC500”. It is highly recommended to check the function of the previous configuration steps.

2.7.5 Check OPC Server V2

Start MobileOPCExplorer.exe, Connect CoDeSys.OPC.02, Add Group, Add Items, select Available Items in ‘Server CoDeSys.OPC.02’, Add to Tag List, Close the Item browser...

If anything is right, then is CoDeSys.OPC.02 is connected, is running and the Quality of the items is good.

With the Matrikon is it possible to read / write the values of the items.
2.7.6 Check OPC Server V3

Start MobileOPCExplorer.exe, Connect CoDeSys.OPC.DA, Add Group, Add Items, select Available Items in 'Server CoDeSys.OPC.DA', Add to Tag List, Close the Item browser...

If anything is right, then is CoDeSys.OPC.02 is connected, is running and the Quality of the items is good.

2.7.7 Check Processes with Windows Task Manager

Correct configuration: All processes run with the same User Name and with the same Session ID.
2.8 Configure AlarmEvents

Refer to REF2 AeConfigurator_UserGuide.pdf for details.

2.8.1 Check AlarmEvents

The function of the AlarmEvents can be also checked with MatrikonOPC Explorer.

The alarm events can be simulated by writing the value of the Items.

2.9 Configure User account for OPC server

Please refer to REF3 Automation Builder Help, Configure User account for OPC Server

2.9.1 OPC Server V3 on Windows Server 2003, … 2016

When running the OPC Server V3 on Windows Server 2003 / 2008 / 2012 multiple sessions need to be supported. Therefore, the installation of the OPC server as service running with a dedicated user account is recommended.
Configuration Steps

- Create specific user, no administrator account is required
- Register V3 OPC Server as service
- Configure V3 OPC Server as service

Create Specific User

![Image of creating a specific user]

Register OPC Server as Service

![Image of registering the OPC Server as a service]

Register the OPC Server executable as service from the command line, see documentation for details

Configure the OPC Server Service

![Image of configuring the OPC Server service]
At Computer Management -> Service & Applications -> Service open the properties of the CoDeSysOPCDAService

Complete the Service Configuration
Check Users and Session during Test Cases

Check the Session ID and User Name of
- Gateway.exe,
- WinCoDeSysOPC.exe, and
- OPC Client

on different test cases like multi session with terminal service sessions

2.10 Session isolation: How to deal with OPC Server and Automation Builder in different sessions?

2.10.1 Situation
In Windows® XP and former Windows OS, services and user applications run together in session 0. With Windows Server 2003 … 2016 and Windows 7 … 10 services run in session 0. User applications run in session 1 or higher (depends of number of users).

Services:
A Windows service is a computer program that operates in the background. Windows services can be configured to start when the operating system is started or can be started manually and run in the background as long as Windows is running. They can operate when a user is not logged on.

Services are:
Windows operating systems include numerous services. OPC clients for example, like S+ OPC scanner PGIM, Aspen CIM-IO Manager, ICONICS, etc. can also be installed as a service.

User applications are:
AutomationBuilder.exe, CoDeSys.exe, MatrikonOPCExplorer, Notepad, etc.
2.10.2 Difficulty

Service and user application are isolated in their session. They cannot communicate with each other directly. See: http://msdn.microsoft.com/en-us/windows7trainingcourse_sessionisolation_unit

The OPC Server as well as the AutomationBuilder and CoDeSys use, the CoDeSys gateway server (gateway.exe) for the communication with the AC500. The CoDeSys gateway server is not able to run in multi sessions.

Case 1:
The OPC Server is registered as service without automatic start. When the user starts the user application CoDeSys and login to a controller, then the CoDeSys starts the gateway in the same session, in which it started, in the user session (>0).
If the OPC server is started later as a service (in session 0), it has the problem that it cannot access to the gateway.

Case 2:
The OPC Server, which is registered as service with automatic start, starts the gateway in the same session (0). If the user application CoDeSys then wants to use the gateway with the communication parameters, connection "local", it does not work.
That can be solved: Changing of the CoDeSys communication parameters to connection: "Tcp/Ip" and Address: "localhost" solves the problem. OPC Server and CoDeSys share the gateway. CoDeSys communicates via the TCP/IP network with the gateway in the session 0.

2.10.3 Different solutions:

- OPC Client and OPC Server must be not run as services: Install all programs AutomationBuilder, CoDeSys, OPC clients and OPC Server, which use the CoDeSys gateway server, in the same user session (>0).
- OPC Client and OPC Server must be run as services: Register OPC Server as service with automatic start (gateway runs then in Session 0). Access from CoDeSys always with the communication parameters, connection: "Tcp/Ip" and address: "localhost". See example: “OPC Server as service and AutomationBuilder access to AC500 V2”.
- OPC Client and OPC Server must be run as services: Install on the PC only the OPC Server (from AutomationBuilder, Tools) and register the OPC Server as service with automatic start. Install on the PC in a VM (Virtual Machine, e.g. VirtualBox) the AutomationBuilder, CoDeSys. The Host and the VM have then their own gateway. The communication with the AC500 runs via network settings of the Host and VM (e.g. network bridge). See example “OPC Client as a Windows service with CBP on the same PC”.
- OPC Client, OPC Server and CoDeSys gateway server as service: With installation of AutomationBuilder under Windows Server OS, the tool "CoDeSys V2.3 Gateway Service Wrapper" installed simultaneously the CoDeSys gateway server as Service with automatic start. Access from the user application CoDeSys always with the communication parameters, connection: "Tcp/Ip" and address: “localhost”. See example: “Windows Server 2016 with OPC Server and CoDeSys Gateway as service and AutomationBuilder access to AC500 V2 and AC500 V3”.
2.11 Gateway communication not possible if gateway port is used by other application

The CoDeSys Gateway Server used TCP port 1210 for communication. The gateway communication is not possible if gateway port is used by other application. It must be ensured that the required Gateway ports (1210 and 1211??) are not occupied by different processes. Otherwise the gateway communication cannot be established.

Possible applications that also use port 1210 and/or 1211 are:
- Java update client??
- ABB 800xA System

If there are problems to establish gateway communication check the usage of port 1210 (via any port scanning tool, e.g. SysInternals) and close the application which uses this port.

By use of 800XA it is sometimes easier to change the port number of the gateway. In this example is the port number of the gateway changed from 1210 to a free port (for example 51000).

To do this open the registry editor (Start/execute and type regedit)

Change the registry key like in the screenshots from 1210 to 51000.
After that must be restarted the server gateway (all applications close, task manager, processes gateway.exe close).

The port number of Gateway communication parameter must be also changed from standard port number 1210 to 51000 (in this example).

The CoDeSys OPC Server Configuration (OPCConfig.exe) must be renewed to enter this change in the OPCServer.ini.

2.11.1 **Windows Server 2012**

At Windows Server 2012 (64 Bit) the path for the Reg Key is

```
HKEY_LOCAL_MACHINE
  Software
    WOW6432Node
      3S-Smart Software Solutions GmbH
        Gateway Server
          Config
            TcpIp
```
2.12 **OPC server does not load the symbol file from AC500**

OPC with symbol file on AC500 does not function. Indeed, the OPC server is shown, but no OPC variables are to be found.

If the OPC server does not load the symbol file (.sdb) from AC500 PLC (FW V2) to PC, the reason can be that the Programming Software 907AC1131 is installed. Please check the registry item:

```
"HKEY_LOCAL_MACHINE\SOFTWARE\3S-Smart Software Solution GmbH\Gateway Server\Config\EnableSymbolFileUpload".
```

If this item is inside, the symbol file will not be loaded from AC500 PLC to PC. For Control Builder Plus this item must be deleted but for AC1131 this item must be available. To check this:

1. In Windows, go to Start → Run, type “regedit”:

   ![Regedit screenshot](image)

2. In Registry Editor, find the folder “Config”:
   - For AC500 FW V2 the item “EnableSymbolFileUpload” must be deleted.
   - For AC1131 this item must be available.
3 Examples

3.1 OPC Client as a Windows service with AB on the same PC

The example describes as DigiVis500 and AB can be simultaneously used on a personal computer without disturbing itself (Motivation: see “Behaviour of the OPC Server V3 with DigiVis500”).

- DigiVis500 and OPC server V3 are installed on the host system.
- AB, with an optional server OPC for test of the communication OPC, are installed on one virtual machine.

3.1.1 Host system

The host system contains of:

- Oracle VM Virtual Box version 4.2.18 (freeware)
- Operation System: Windows 7, Professional 32 bit, SP1
- DigiVis500 Version 1.0SP2 US
  - Graphics Builder Version 1.0.7780 SP2
  - Operations Version 1.0 SP2 (7780)
  - OPC Tunnel, Softing OPC Easy Connect – OEM ABB DigiVis500 V 1.44.0.1707
- OPC Server V3 (from CBP V2.3.0, see “OPC Server versions and OPC Tools”)
  - WinCoDeSysOPC.exe V3.5.2.0
  - OPCConfig.exe V3.5.2.0RC?
  - AEConfiguration.exe V1.0.0.3
- CoDeSys gateway server, Gateway.exe V2.3.9.28

3.1.2 PC configuration

Network settings

```
C:\Users\ACM2>ipconfig
Windows-IP-Konfiguration

Ethernet-Adapter LAN-Verbindung:
Verbindungsspezifisches DNS-Suffix:  
Verbindungslokale IP-Adresse: 1e0012cd2171:8all:586b:192.168.2.253
IPv4-Adresse: 192.168.2.253
Subnetzmaske: 255.255.255.0
Standardgateway: 192.168.0.1
```
3.1.3 DigiVis500 configuration

DigiVis500 Version 1.0SP2 US

The DigiVis500 does not work with the local IP 127.0.0.1 (OPC-S shows an error "Invalid computer name"). So, I configured PC with a fixed IP 19.168.9.253.

With DigiVis500 installation the ABB OPC Tunnel is installed and registered automatically as service (session 0) with "Startup type: Automatic". Automatic means that the ABB OPC Tunnel will start as soon as the Windows system starts up.

With the start of the ABB OPC Tunnel (OCTsvc.exe), the OPCServer (WinCoDeSysOPC.exe) and also the CoDeSys gateway server (Gateway.exe) are started in session 0.

After loading of the Graphics Builder configuration into the Operation, the Operation is running with actual OPC values.

All relevant processes

- OPC Tunnel
- Gateway.exe
- WinCoDeSysOPC.exe

are running in the same session.
3.1.4 **Guest system**

The guest system contains of:

- Oracle VM Virtual Box version 4.2.18 (freeware)
- PS501 Control Builder Plus 2.2.0 (see “OPC Server versions and OPC Tools”)
  - CoDeSys gateway server, Gateway.exe V.3.9.9.24
  - OPC Server V3, WinCoDeSysOPC.exe V3.4.4.10
  - OPCCConfig.exe V3.4.4.10

Network setting: Using the Ethernet adapter of the host as network bridge.
The programming and testing can be made within the VM without restrictions.

The OPC configuration can be made and testing with a OPC test client, e.g. MatrikonOPCExplorer.
All relevant processes

- CoDeSys.exe
- Gateway.exe
- MobileMatrikonExplorer.exe
- WinCoDeSysOPC.exe

are running in the same session.

3.2 OPC Server as service and Automation Builder access to AC500 V2

OPC Server as service and AutomationBuilder/CoDeSys access to PLC AC500 V2 with communication parameters "Tcp/Ip" and "localhost".

3.2.1 Communication settings for OPC Server with OPCCConfig.exe
### 3.2.2 Communication settings for PLC AC500v2 in Automation Builder

**Communication Settings for **AC500_PM505_ETH**

- **IP Address**: 192.168.106.50
- **Use advanced settings**: checked

**Use advanced settings**

**Setting of IP address**

**Gateway settings**
3.3 Windows Server 2016 with OPC Server and CoDeSys Gateway as service and Automation Builder access to AC500 V2 and AC500 V3

OPC Server and CoDeSys gateway server are installed as service. The Task Manager shows, that they are running permanently in session 0.

3.3.1 AutomationBuilder project with PLC_AC500_V2 (PM556-ETH) and PLC_AC500_V3 (PM5650-2ETH)

Communication parameter of AC500 V2
Communication parameter of AC500 V2

With the Communication parameter of AC500 V2 and AC500 V3 run the communication to the PLC.

The Task Manager proves that. The AutomationBuilder and Codesys running in the user session 2 and communicate via the Gateway in session 0 with the PLCs.
3.3.2 Communication settings for OPC Server with OPCCConfig.exe

Settings OPC Server

Connections parameter to PLC AC500 V2
3.4 How can the OPC Server V3 communicate with duplicated Automation Builder AC500 V2 projects?

The example shows how the OPC server can communicate with a lot of similar PLC AC500v2, which were generated by duplicating from an Automation Builder project (always the same project name with different IP addresses).
After configuration of the “Symbol Configuration”, setting “Download symbol file”, build, download and flash program (see: Commission OPC server) is a file Application .SDB with current time stamp in the folder C:\ProgramData\Gateway Files.

3.4.1 Communication settings for OPC Server with OPCCConfig.exe

OPC Server settings with allocated names to the PLCs.

Important: Corresponding PLC name PLC3_56 in the "Project name" field.

Important: Corresponding PLC name PLC3_64 in the "Project name" field.

Communication parameter PLC3_56

Communication parameter PLC3_64
Important: Corresponding PLC name PLC3_65 in the "Project name" field.

For PLCs that have been created by duplicating Automation Builder projects, the corresponding PLC name must be written in the "Project name" field. This is necessary so that the OPC server can read the corresponding OPC item list for each PLC.

When the OPC client starts, the OPC server loads the OPC Items list from each PLC via the gateway and stores it in form of "Project name".sdb on C:\ProgramData\Gateway Files\Upload.
3.4.2 Test of the OPC communication with MatrikonOPCExplorer

MatrikonOPCExplorer runs only in the user application, therefore the OPC Server V3 was installed as user application for the demonstration. Of course, the example also works similar, when OPC Client and OPC Server V3 are configured as a service.

The Task Manager shows the sessions. The OPC Client (OPCExplorer), OPCServerV3 (WinCoDeSysOPC) and CoDeSys OPC Service (Gateway) run in the same user session.

Pic up of the OPC items from corresponding PLCs.

The communication to the PLCs is running and have a good quality.
4 Appendix

4.1 Test OPC Function without AC500

The example shows, how the OPC server V2/V3 can be tested/simulated without available AC500.

4.1.1 AC500 project

Collect all OPC variables in a separate Global variable list.

Configuration of the symbol files: <Project> <Options> <Symbol configuration>
the option “Dump symbol entries” must be selected. Then <Configure symbol file>
Empty symbol file: Remark all Checkboxes, OK, OK and push „Configure Symbols“ once more

Mark the OPC_Variables and the Checkboxes. OK OK
In the project folder is the folder “OPC_test1__AC500_PM573_ETH__OPC_test1”. It contains symbol files *.SYM and *.SDB with the time of the “Rebuild all”. The items in the file *.SYM can be checked with Notepad.

The binary file *.SDB contains the items for the OPC server. With <Online> <Login> will it copied in the gateway files directory and optionally on the AC500.

The folder “OPC_test1__AC500_PM573_ETH__OPC_test1” is a temporary folder, if the AB project is opened. For the simulation of the server OPC it is copied *.SDB by hand.
4.1.2 Configure OPC Server V3

Keep the default values.

Project name with the directory name has to be specified. Connection settings is not necessary for the simulation.
4.1.3 Configure OPC Server V2

Only the project name may be specified.
4.1.4 Check OPC Server with MatrikonOPCExplorer

OPC Server V3: Connect CoDeSys.OPC.DA, Add Group, Add Items, select Available Tags, Add to Tag List...

The OPC Server V3 (CoDeSys.OPC.DA) is connected, running and the Quality is good. One OPC client can read / write the values of the items.
Similar configuration how above.
The OPC Server V2 (CoDeSys.OPC.02) is connected, running and the configured items are found. But the quality is bad. One OPC client can not read / write the values of the items.

4.1.5 Check Processes with Windows Task Manager

Correct configuration: All processes run with the same User Name and with the same Session ID.
4.1.6 Summary

The correct function of OPC Server V2 and V3 can be checked without AC500. With OPC Server V3 with the configuration SIMULATION the Project name with the directory name has to be specified. The values of the items can be read and write by one OPC client.

With OPC Server V2, as well as with OPC Server V3 in configuration GATEWAY, only the project name may be specified. The configured items are found, but the Quality is bad. The values of the items cannot be read and not write by one OPC client. Refer to REF1 and REF6 for details.

4.2 Windows 7, 64Bit with OPC Server V3 access to the local Symbol file.

Create a new project and take a look of your symbol file. The project must be opened to see this file.
Copy your *.sdb file to the following folder: C:\Windows\Gateway Files

Open the OPCConfig. The Project name **must** be the same name as the symbol file. Please activate all three check boxes.
Set the connection to the PLC.

Save the current OPCServer.ini in the following folder: C:\Programme (x86)/ABB/CoDeSys OPC Server 3 AE.

Check the OPC connection with an OPC client e.g. Matrikon.
4.3 Behavior OPC Server V3 via Interface IOPCAsyncIO

Using of an OPC client (1) with the older OPC standard Interface IOPCAsyncIO (OPC DA V1.0a) creates a higher communication load on the OPC client, because the OPC-Server sends also the unchanged items in every scan cycle to the client.

Test setup:

Reason:
If OPC Items are registered via Interface IOPCAsyncIO (OPC DA V1.0a), the OPC Server sends mostly with each ready cycle a data change event, including also unchanged values. The change detection is correct when using the interface IOPCAsyncIO2 (OPC DA V2).

Workaround:
- Use the interface IOPCAsyncIO2 (OPC DA V2).
- If the OPC client does not support IOPCAsyncIO2 interface, then use the OPC Server V2. The OPC Server does not show this behavior.

OPC client (1): Visualization software inVISU PMS (Fa. Epro GmbH) uses an older standard OPC with the interface IID_IAdviseSink than data sink.
4.4 Comparison with OPC Server V2 to V3: Transmission rate

Some figures about OPC Server transmission rates of a special test setup of HHZ:

- PC Lenovo T430, Windows 7, 64Bit
  - OPC client (OPC Systemtest Teststand, LabView 8.6 application)
  - OPC Server V2 und V3
- AC500 PM592 (task freewheeling and \( t=2 \) ms shown similar values)
- OPC client application: 100 cycles (write item, read item, compare value, increment value)

<table>
<thead>
<tr>
<th>Item Byte</th>
<th>Connect [ms]</th>
<th>Mean value [ms]</th>
<th>Max. value [ms]</th>
<th>Disconnect [ms]</th>
</tr>
</thead>
<tbody>
<tr>
<td>OPC Server V2: write cycle</td>
<td>2</td>
<td>2,374</td>
<td>4</td>
<td>0</td>
</tr>
<tr>
<td>OPC Server V2: read cycle</td>
<td>2</td>
<td>127,2</td>
<td>133</td>
<td>0</td>
</tr>
<tr>
<td>OPC Server V3: write cycle</td>
<td>2</td>
<td>1,838</td>
<td>4</td>
<td>1</td>
</tr>
<tr>
<td>OPC Server V3: read cycle</td>
<td>2</td>
<td>96,8889</td>
<td>99</td>
<td>1</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Item real (8 Byte)</th>
<th>Connect [ms]</th>
<th>Mean value [ms]</th>
<th>Max. value [ms]</th>
<th>Disconnect [ms]</th>
</tr>
</thead>
<tbody>
<tr>
<td>OPC Server V2: write cycle</td>
<td>1</td>
<td>2,333</td>
<td>4</td>
<td>0</td>
</tr>
<tr>
<td>OPC Server V2: read cycle</td>
<td>1</td>
<td>127,152</td>
<td>133</td>
<td>0</td>
</tr>
<tr>
<td>OPC Server V3: write cycle</td>
<td>1</td>
<td>1,616</td>
<td>3</td>
<td>1</td>
</tr>
<tr>
<td>OPC Server V3: read cycle</td>
<td>1</td>
<td>97,1414</td>
<td>99</td>
<td>1</td>
</tr>
</tbody>
</table>

4.5 Performance Comparison with OPC Server V3 and different TCPIP drivers:

Measured on a Lenovo ThinkPad with Core-i5, Windows 7-64, 8GB RAM using a minimum OPC-Client (console application) written in C# with use of OpcNetApi-Library.

V2.3 project with 5 AC500 PLCs

<table>
<thead>
<tr>
<th>TCPIP DRIVER NAME</th>
<th>Buffer size setting in opcserver.ini</th>
<th>Average CPU Load (PM591)</th>
<th>Throughput Cyclic items per second at OPCClient</th>
</tr>
</thead>
<tbody>
<tr>
<td>3S TCPIP</td>
<td>0</td>
<td>16%</td>
<td>8500</td>
</tr>
<tr>
<td>ABB TCP/IP Level 2 AC</td>
<td>1000</td>
<td>19%</td>
<td>2886</td>
</tr>
<tr>
<td>ABB TCP/IP Level 2 AC</td>
<td>5000</td>
<td>19%</td>
<td>4770</td>
</tr>
<tr>
<td>ABB TCP/IP Level 2 AC</td>
<td>7000</td>
<td>19%</td>
<td>5202</td>
</tr>
</tbody>
</table>
4.6 **OPC Server V3 with S+**

Test with ABB PS Mannheim, 2012. Communication via OPC with AC500 in "ABB Kinderferienhaus Schapbach".

**Setup:**
- Windows Server 2008 64 Bit
- S+
- OPC Server V3

**Procedure**
- Install OPC-Server V3 from folder AB. After the installation OPC server runs in session ID: 1
- Test with OPC test clients, as Softing or Matrikon OPC, if the dates are able to be called up.
- The S+ OPC-Scanner runs as a service. Configure OPC Server V3 according to Hints, Configure User account for OPC server. The OPC server runs then in session ID: 0
Setup:
- Windows 7, Professional 32 bit, SP1
- DigiVis500_SP1

With DigiVis500 installation the ABB OPC Tunnel is installed and registered automatically as service (session 0) with "Startup type: Automatic". "Automatic" means that ABB OPC Tunnel will start as soon as the Windows system starts up.

With the start of the ABB OPC Tunnel (OCTsvc.exe), the OPCServer (WinCoDeSysOPC.exe) and also the CoDeSys gateway server (Gateway.exe) are started in session 0.

**NOTICE**

Communication of AB or CoDeSys (session 1) with AC500 is not possible more. They need the Gateway.exe in session 1, but the CoDeSys gateway server is not able to run in multi sessions.

To use AB or CoDeSys, the OPC tunnel service must be stopped. This can be done in Component Service, Service (local), ABB OPC Tunnel with the "Start", "Stop" buttons.
BUBMAIN.EXE is DigiVis 500 Operation

An example of a working setup on one PC with AB into a virtual machine is described in "Examples, OPC Client as a Windows service with AB on the same PC".

### 4.8 How can one demonstrate DigiVis500 without AC500?

#### 4.8.1 PC configuration

Windows 7 Professional, 32 Bit

```
C:\Users\ACM2>ipconfig
Windows-IP-Konfiguration

Ethernet-Adapter LAN-Verbindung:

Verbindungspezifisches DNS-Suffix:  
Verbindungslokalen IPv6-Adresse: fe80::2c2:7141:8a8d:50cb
IPv4-Adresse: 192.168.9.263
Netzmaske: 255.255.240.0
Standardgateway: 192.168.0.1
```
OPC Server V3 version from CBP V2.2

4.8.2 DigiVis500 configuration

The DigiVis500 does not work with the local IP 127.0.0.1 (OPC-S shows an error "Invalid computer name"). So, I configured PC with a fixed IP 19.168.9.253.
4.8.3 Changing the OPCConfig to Simulation mode

According to CoDeSys_CoDeSys_OPC_Server_V3_User_Guide.doc: 6.3.2 SIMULATION

In the OPC server INI file, a simulation access by Gateway V2.3 connection is configured by selecting the interface SIMULATION and by setting the name of the symbol file in Project name. The symbol file is automatically generated by a build command of a CoDeSys V2.3 project when in Options -> symbol configuration the corresponding options are set. The symbol file is stored in the same directory as the project file and has the extension SDB. If the symbol file is stored in the OPC server directory, then the directory name has not to be specified.

But it can also be copied to any location, then under Project name the directory name has to be specified.

In this example is the *.sdb located on c:\ProgramData\Gateway Files\AC500.sdb

4.8.4 Checking with MatrikonOPCExplorer and DigiVis500
4.9  How do you create an OPC client with Microsoft Excel?

See www.abb.com/plc Application Example, OPC

This application example consists of two parts:

- AC500_to_OPC_Excel_Client.pro: AC500eCo project with symbol and CoDeSysOPC
- OPC_Excel_Client.xls: MS Excel sheet with VBA program

Block diagram
Worksheet “Control panel” for the communication with the OPC-Server.

Worksheet “Overview” for visualization.

NOTICE

This works also with OPC Server V3 but because of a missing DLL the OPC Server V2 must be installed also (Will be fixed in later Releases as V2.3)